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0. Introduction (1/2): Main Problems of Data Management
[Sto 98, Ozs 16, ...]

“Data needs to be: <Captured, Cleaned, Stored, Queried, Processed
and Turned in Knowledge>"

« Data Modelling & Semantic

o Query Processing & Optimization (OLAP Online Analytical Processing)

o Concurrency Control/Transactions (OLTP Online Transactional Processing)

o Replication & Caching

o Cost Models

o Security & Privacy

o Monitoring Services

o Resource Discovery

o Autonomic Data Management (self-tuning, self-repairing, ...), ...

=» Data Management Systems DMS
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0. Introduction (2/2) : Evolution of Data Management Systems [Gra 96]

® "The present without past has not future” Frernand Braudel

» <Concept = Systems: Objective>

File Management Systems FMS: Storage Device Independence

Uni-processor DB Systems DBMS [codd 70): Prog-Data Independence
Parallel DBMS [Dew 92, Val 93]: High Perf., Scalable & Data Availability
Distributed DBMS [0zs 16]: Location/Frag./Replication Transparency

Data Integration Systems [Wie 92]: Uniform Access to Data Sources
Characteristics =<Distribution, Heterogeneity, Autonomy>

Data Grid Systems [Fos 04]: Sharing of Available Resources
Mobile Database Systems [Oza 08, Mor 11]: Decentralized Control
B Cloud Data Mana. Systems [Aba 09, Sto 10]: Pay-Per-Use W Economic Models

Characteristics =<E/asticity, Fault-Tolerant >
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Evolution of Data Management Systems

From File Mana. Systems FMS to Database MS DBMS

¢ Motivations, Objectives, Files Organizations & Drawbacks
¢ Databases & Rel. DBMS: Motivations & Objectives

II. Parallel Relational DBMS
+ Motivations Objectives, Characteristics and Challenges

+ Parallel Query Processing
+ Optimization of Data Communications: Plague of Parallelism

II1. From Distributed DBMS to Data Integration Systems DIS

¢ Motivations, Objectives & Designing of Distributed DB

¢ Distributed Query Processing & Soft. Architecture
¢ Mediator-Wrappers Architecture & Query Processing Methodologies

IV. Cloud Data Management Systems CDMS
¢ Motivations, Objectives & Main Characteristics of CDMS
¢ Classification of CDMSs : 3 Generations (G1, G2 & G3)
¢ Advantages & Weakness of MR Systems & Parallel DBMSs
¢ Comparison between Parallel DBMSs & MR Systems

V. Conclusion & References
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Evolution of Data Management Systems:
Cloud Data Management Systems CDMS

Outline

I. Background & Fundamentals: [Codd 70, Sel 76, Dew 92, Val 93, ...]

¢ From FMS to DBMS: Objectives & Limitations
¢ Parallel Rel. DBMS: Motivations, Characteristics & Challenges
¢ From Distributed DBMS to Data Integration Systems DIS

I1. Cloud Data Management Systems CDMS [Aba 09, Sto 10, ...]
¢ Motivations & Main Characteristics of CDMS
¢ Classification of CDMS : 3 Generations (G1, G2 & G3)
¢ Applications: Petasky — Mastodons Project [Mas 16]
¢ Advantages & Weakness of MR Systems & Parallel DBMSs
¢ Evolution of DML for CDMS (G1)

¢ Comparison between Parallel Rel. DBMSs & MR Systems (G1)
III. Future Research Directions [Abadi 22, The Seattle Report on DB Research]
IV. Conclusion 5
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I. Background & Fundamentals B & F
1. File Management Systems (1/2)

M File Concept
®  program and Storage Device Independence

[Storage] <File> [Program/Application]

» Software Eng. Requirements
B File Organizations: 4 types

o < Sequential /Indexed > Organizations
o < Hashing/Relative> Organizations
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I. Background & Fundamentals B & F
2. File Management Systems (2/2)

B Access Methods AM
. Sequential AM
o Key AM :=<Indexed/Hashing> AM

B Drawbacks of FMS

o Data description must be done in each program

o Relationships/Links between files are materialized
(= New files)

®» Database Concept
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I. Background & Fundamentals B & F
3. Databases DB and Relational DBMS [Codd 70]
B DB Objectives:

P Separation between Data Structures (DB Schema) & Program.

» Prog-Data Independence = <Physical & Logical> Independence

B DB Models: <Hierarchical, Network, Relational & Object>

B Main Characteristics (Rel. DB)

o Structured Data: Relation Concept to describe <Entities & Links>
o Relational Algebra: Commutative, Internal Law

o Rel. Languages: From Procedural = Declarative Languages: SQL
[Cham 76], QUEL [Sto 76], QBE [zlo 77], ....

P The System will find the (near) Optimal Access Path
» Optimizer [Sel 79, Wong 76, Gan 92, ...]
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I. Background & Fundamentals B & F
4. Uni-proc. Rel. DBMS: Query Optimization [Sel 79]

B Problem Position [Gan 92]:
q < Query, p € {Execution Plans}, Cost, (q):

* Find p calculating q such as Cost, (q) is minimum
® Objective : Find the best trade-off between

Min (Response Time) & Min (Optimization Cost)
B Optimizer Structure= < St, Sp, C> [Gan 92]

— St: Search Strategies (= Intelligence)
® <Physical Optim., Parallelization, Resource Allocation, ...>

— Sp: Search Space (= Control)
» Data Structures/Queries: Linear Spaces, Bushy Space
 Type/Nature of Queries

— C: Cost Models (= Knowledge)
e <Metrics, System Environment Description>
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I. Background & Fundamentals B & F
5. Limitations of Uni-proc. Query Optimization Methods
wrt Decision Support Systems /OLAP

Complex Queries: Number of Joins >6
Size of Research Space [Tan 91]: Very Large (e.g. 2V-1)

o Optimization Cost [Lan 91]: can be very expansive (e.g. Deterministic
Strategies wrt Random Strategies)

o Optimal Execution Plan: not guaranteed (e.g. Random Strategies)
» Requirements in: High Performance HP & Resource Availability

» Introducing a New Dimension: Parallelism

» Parallel Relational Database Systems [Dew 92, Val 93, ...]
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I. B & F: 6. Parallel Relational DBMS (1/2) [Dew 92, Val 93, Lu 94,.. .]

B Motivations: Declarative Relational Languages (e.g. SQL)
o Automatic Parallelization of <Intra-operation & Inter-operation>

o Parallelism Forms: <Partitioned & Independent, Pipelined> [/
o Regular Data Structures : & Static Annotations
o Decision Support Queries: Complex Queries, Huge DB (TB, PB, ...)

B Objectives [Dew 92]:
e Best Trade-off between Cost/Performance wrt Mainframe
e High Performance HP
¢ Minimizing the Response Time
¢ Maximizing the Parallel System Throughput

® Scalability (# Elasticity)
¢ Adding New resources (CPU, Memory, Disk)
¢ Adding New Users (Applications)

®» Holding the Same Performance
® Resource Availability: Complex Queries, Fault-Tolerant

IRIT, Hameurlain@irit.fr, February, 2024 11



I. B & F: 6. Parallel Rel. DBMS (2/2) [Dew 92, Val 93, Lu 94,.. .]

B Main Characteristics
® Parallel Architect. Models: SM, SD, DM= Shared-Nothing Architecture

® Parallelism Forms: <Partitioned, Independent, Pipelined>
® Data Partitioning:
e Approaches: <Full Declustering, Partial Declustering>
o Methods: <Round Robin, Range Partitioning, Hashing>
B Main Challenges
® Parallelism Degree of each Relation/Operator (e.g. Join)?

® Parallelization Strategies: <One-Phase, 2-Phases> Approaches>
® Resource Allocation: Data & Tasks Placement/Scheduling

e Optimization of Data Communications: Plague of Parallelism!
B Weakness of Parallel Rel. DBMS

® Run only on Expensive servers
* Web Data Sets are not structured (Relational Schemas)

* Weak Fault - Tolerance
° Communication Costs: Data Redistribution (=Reshuffling in MR)

... Towards Cloud Data Management Why ?
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II. Towards Cloud Data Management Systems CDMS

[Aba 09, Sto 10/13, Agr 10-12, Chaud 12, Zhou 12, Kald 12, Gra 13, LI 14,
Unt 14, Norvag 14, Akba 15, Bon 15, Aba 16 ...]

Outline

B Big Data, Cloud Computing & MapReduce MR: Motivations?
B Main Characteristics of Cloud Systems [D. Agrawal 2011]

®"Hot Debate” on: MapReduce Versus Parallel DBMS: friends or foes?
[M. Stonebraker et al., 2010], [D. Agrawal et al. 2010, S. Chaudhauri 2012 ]

®"” Reconciling Debate” [Zhou 2012, Kaldewey 2011]
“SCOPE : Parallel Databases Meet MapReduce” [Zhou 2012]

B Classification of Cloud Data Management Systems CDMS

B Advantages & Weakness of Parallel RDBMS & MR Systems

B Applications: Petasky — Mastodons Project [Mas 16]

B Evolution of DML & Compar. between Par. RDBMS & MR Systems
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I1I.1 Motivations (1/2): Big Data & Cloud Computing

B Big Data? : Generated from specific requirements of Web Appli.
<+ Tradit. Appli. : C. Sim, Sat. , Astronomy, Live Sc, Buisness, ....

Remark: 50t Intl. Conf. on Very Large DB; 49th Intl. Conf. On Manag. of Data
» Big Data & "Moving Target" [Val 16]

B Big Data Characteristics: the 3 V’'s (Volume, Velocity, Variety)
» What are the Solution for “the 3 V's” [Val 14] ?

e Volume: Refers to very large amounts of Data

®» Parallel Database Systems [Dew 92]
® Velocity: Streaming Data

®» Data Stream Management Systems [Ozu 16]
® Variety: Heterogeneity of Data Formats, Semantics & Resources

®» Data Integration Systems [Wied 92]
However, why these systems are not naturally used?
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I1.1 Motivations (2/2): Towards Cloud Computing & MapReduce

®» Observation (Buisness Idea!): “One size does not fit all” [Sto 2010]

B Current Solutions (Infrastructures & Software/RDBMS) are:
Proprietary & Expensive

®» Open Source Alternatives, Simple Programming Model ! (e.g.
MapReduce), Low Costs LC (Commodity Hardware CH)

B Ability to scale resources out up and down dynamically
on- demand: = Elasticity (2 Pay-Per-Use PPU)

B How the systems should react “strongly” to Failures?
<Commodity Hard./LC, Data Replication, HDFS> ® Fault-Tolerance

B Cloud Environments do not to be Owned nor Managed by a
Customer (PPU Approach): Users = Multi-tenant

» <Tenant, Provider> through SLA (Service Level Agreement)

IRIT, Hameurlain@irit.fr, February, 2024 15



I1.2 Main Characteristics of Cloud Systems [Agra. et al. 2011]

B Scalability (Infrastructure: Shared-nothing Architecture)
B Elasticity [0zu 16]:

«The ability to scale resources out up and down dynamically to
accommodate changing conditions»

B Strong Fault-Tolerance:
® Ability to run on Commodity Hardware CH (Low Cost!)
® Data Replication (e.g. HDFS)

B Users & Multi-tenant [Nara 13]: <Tenant, Provider> trough
SLA (Service Level Agreement) Meeting

®» New Context = <Service on-demand, Multi-tenant, Commodity Hardware >

®» Introduction of ECONnOomic Models in the Resource Managemen
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I1.3 Classification of Cloud Data Manag. Systems CDMS (1/3)

M 15t Generation G1: From MapReduce MP & SQL- Like

® MP Systems =»SQL on-Hadoop Systems based on Type of Data Store:
<Key-value Store, Document Store, Column —Family, Graph DB >

- Simple Queries= Selection Queries
- Bigtable, Hive, MongoDB, Cassandra, Neo4j, Riak, Spark, ...

M 2nd Generation G2: From Parallel RDBMS = Multi-tenant Par. RDBMS

® Extension of Parallel Rel. RDBMSs with the “Cloud Concept”
= <High Performance & Elasticity> [Won15, Yin 18, ...]

- Complex Queries= Join Queries
- Amazon Redshift, Azure SQL DW, Google BigQuery, Snowflake DW, ...

B 3rd Generation G3: =<Distribution, Heterogeneity, Autonomy>
based on the concepts: <Multibase/Federated DB & Data Integration>
e Multistore/Polystores Systems: Polybase [Dew 13], SCOPE [Zho 12],
CoherentPaas Proj. [Bon 15], BigDAWG [Sto/Dug 15], [Sol 20], [Lec 18], ...

17
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I1.4 15t Gener. G1 : From MR 2 SQL Like on-Hadoop Systems

B Classification of NoSQL Systems : Type of Data Store
®» Observation (Buisness Idea!): "One size does not fit all” [Sto 2010]

® Key-value Store: <Azure Table Storage, DynamoDB,
Redis, Riak, Voldemort, ...>

® Document Store (XML, JSON): <MongoDB, CouchDB, RavenDB>

® Column-family (Rel. DB, Data is stored in column):
<Hbase, Cassandra, Hypertable>

® Graph Databases (Social Networks):
<Neo4j, Infinity Graph, InfoGrid, ...>
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I1.5 15t Gener. G1 : From MR = SQL - Like on-Hadoop Systems (1/2)

» Advantages and Weakness of MR
B Advantages of MapReduce MR

* Scaling very well (to manage massive data sets)

- Strong Fault -Tolerance (Data Replication, HDFS)

« Mechanism to achieve Load-Balancing

- Support only the Intra-Oper. & Independent Parallelisms (Pipeline Par.?)

B Weakness of MR: Side Applications

Developers:
* Are forced to translate their business logic to MR model
* Have to provide implementation for the M & R functions
* Have to give the best scheduling of M & R operations

=» More Hot Problems wrt Data Management!

* Prog-Data Structure Independence is lost (DB Objective !)

* Extensive Materialization (I/0O) (the Pipeline // is not implemented)

* Data Reshuffling (Redistribution) between M & R » Plague of Parallelism
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I1.5 15t Gener. G1 : From MR = SQL Like on-Hadoop Systems (2/2)

» Advantages and Weakness of Par. RDBMS

B Advantages of Par. RDBMS [Dew 92]

* Relational Schemas (=& Easy Annotations/Metadata)
- Declarative Query Languages (= Automatic Optimization Process)

* Sophisticated Query Optimizers-Parallelizers : {Partitioned, Indep., Pipelined //}
* +/- Comm. Costs : Avoid the Data Redistribution (+/-: in some cases)

B Weakness of Par. RDBMS

® Run only on expensive servers
* Weak Fault - Tolerance
* Web Data Sets are not structured (Relational Schemas)

* Communication Costs: Data Redistribution (=Reshuffling in MR)
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I1.6 Comparison between Par. RDBMS & MR Systems 15t Gener. (G1)

Systems Par. RDBMS MapReduce Systems (Hadoop
Parameters Env.)/ 15t Generation
Type of Applications OLAP & OLTP (ACID) | OLAP: Yes;
OLTP: Not suitable (I _(I_mtlallyl)
= NewSQL (HTA
Data Models Structured Data Unstructured or semi-
(Relational Schema) Structured , ...(more Flexible!)
Data - Prog Independ. |Yes No (Initially)
Query Languages Declarative Procedurals (initially)

Optimization &
Parallelization

Automatic Optim. & //

Annotations: Easy

Explicit Optim. (initially)

Annotations: Very difficult

Scalability & Elasticity

Scalable & Dynamic

Scalable & Elastic

Fault-Tolerance

Weak

Strong

Location

Maturity

Known in advance

SLA Negotiation

Weak (at this moment!)
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I1.7 Evolution of Data Manip. Languages for CDMS/1st Generation

Charact. 2 Functions Advantages Drawbacks
(Power)
Nature of
Languages
L1: Proc./Func. | Filter & Project |- Simplicity of - Complexity to read

Languages
(e.g. MapReduce)

[Bigtable, PNUTS]

Google, Yahoo!

Programming
Model!

and optimize prog.

- Data Str. Dependency

Relational Towards SQL rgﬁgbf‘ere more Schedurl)ing gf Rel. Op
Operators func — Automatic = No Physical

Logical Optim. Optimization
[PIG Latin, Jaql] Yahoo!, IBM
L3: Automatic : “Lack of statistics
Declarative Elg;eeé%iQL - Optimization stored in
Languages Operators - Parallelization The catalog” =
[HiveQL, (= Avoid Data “Blinds the optimization
SQL/ SPARK, MS, FB, IBM & | Reshuffling) Process”
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I1.8 Petasky — Mastodons Project (CNRS, LIMOS/LIRIS)

“Benchmarking SQL on MapReduce systems using large astronomy
databases”; A. Mesmoudi et al.; In: Intl journal PDBD, 34(3), 2016

B Objectives: “They report on the capability of 2 MR systems
(Hive and HadoopDB) to accommodate LSST* data management
requirements” in terms of loading & execution times : < Data
Loading & Indexing and Queries (Selection, Group By, Join) >

B Conclusions [Mes 2016] :

» “We believe that the model is efficient for queries that
need one pass on the data (e.g. Selection and Group By)”

» “ We believe that MR model is not suitable for handling
Join queries ”

* LSST : Large Synoptic Survey Telescope
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I1.9 Classification of Cloud Data Manag. Systems CDMS (2/3)

B 15t Generation G1: From MapReduce MP 2 SQL- Like

® MP Systems =»SQL on-Hadoop Systems based on Type of Data Store:
<Key-value Store, Document Store, Column —Family, Graph DB >

- Simple Queries= Selection Queries
- Bigtable, Hive, MongoDB, Cassandra, Neo4j, Riak, Spark, ...

M 2nd Generation G2: From Parallel RDBMS = Multi-tenant Par. RDBMS

® Extension of Parallel Rel. RDBMSs with the “Cloud Concept”
= <High Performance & Elasticity> [Won15, Yin 18, ...]

- Complex Queries= Join Queries
- Amazon Redshift, Azure SQL DW, Google BigQuery, Snowflake DW, ...

B 3rd Generation G3: =<Distribution, Heterogeneity, Autonomy>
based on the concepts: <Multibase/Federated DB & Data Integration>
e Multistore/Polystores Systems: Polybase [Dew 13], SCOPE [Zho 12],
CoherentPaas Proj. [Bon 15], BigDAWG [Sto/Dug 15], [Sol 20], [Lec 18], ...

24
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I1.9.1 2nd Gen.: Multi-tenant Par. RDBMS (Par DB-as-a-Service PDBaaS)

2 Approaches to provide PDBaaS: A1 & A2
<Elasticity, High Performance, Cost-effectiveness>

B A1l: Exclusive Resource Approach
® Hard Isolation between Tenants

» Meeting tenant SLAs
® Poor Resource Utilization ( Low Cost — Effectiveness)

B A2: Shared Resource Approach
® Soft Isolation between tenants

®» SLAs may not be guaranteed (= Penalty, thresh-hold)
® Better Resource Utilization: Avoid Resource Contention

®» Elastic Resource Allocation Models [Kan 19, Won 15,. ..]
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I1.10 Classification of Cloud Data Manag. Systems CDMS (3/3)

B 15t Generation G1: From MapReduce MP 2 SQL- Like

® MP Systems =»SQL on-Hadoop Systems based on Type of Data Store:
<Key-value Store, Document Store, Column —Family, Graph DB >

- Simple Queries= Selection Queries
- Bigtable, Hive, MongoDB, Cassandra, Neo4j, Riak, Spark, ...

B 2nd Generation G2: From Parallel RDBMS = Multi-tenant Par. RDBMS

® Extension of Parallel Rel. RDBMSs with the “Cloud Concept”
= <High Performance & Elasticity> [Won15, Yin 18, ...]

- Complex Queries= Join Queries

- Amazon Redshift, Azure SQL DW, Google BigQuery, Snowflake DW, ...

H 3'd Generation G3: -<bistribution, Heterogeneity, Autonomy>
based on the concepts: <Multibase/Federated DB & Data Integration>

e Multistore/Polystores Systems: Polybase [Dew 13], SCOPE [Zho 12],
CoherentPaas Proj. [Bon 15], BigDAWG [Sto/Dug 15], [Sol 20], [Lec 18], ...

26
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I1.10.1 31 Generation: Multistore/Polystore Systems (1/2)

Strongly Inspired: Data Integration Systems [Wied 92, Gol 00, Yer 99, ...]

Question : Quels sont les numéros de téléphones des Medecins traitant des employés
de la section Informatique dont Durand est le responsable ?

B Requirement: Data Integration arising from Several Sources
B Characteristics: <Distribution, Heterogeneity, Autonomy>
B Objective: Uniform Access to Data Sources

Investigation DBénﬁalr(')S etérsw- InforImation Syztem of
Responsible ploy an Insurance Comp.

XML Files Oracle DBMS DB2 DBMS  Yellow Pages
» Mediator-Wrapper Architecture [WIE 92]
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3rd Generation: A Case Study

M 11.10.2: Polystore System with BigDAWG [Dug 15]

| Clients | Visualizations | Streams [ Apps |

Array Island Relational Island Island X
[Shim|  [Shim | [Shim ]

e BB s

W AT T o <V
§ 1 1 I

/ Array DBMS nnm\msx RDBMS ¥ Streaming
e.g., SciDB [Brol0] :

Archived Time
Series Data

e.g., Postgres : e.g., S-Store [Cet14] :
Patient Metadata Real-time Waveform Data
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II1.1 Future Research Directions (1/5)

B New Context in CC= <Service on-demand, Multi-tenant, Commodity Hardware>
®» Introduction of Economic Models in the Resource Management

B Research Challenges [Abadi et al. 2022; “The Seattle Report on DB Research”]
RC1: "Data Science”

< Data-to-Knowledge Pipeline, Data Context & Provenance, Data Manag. in
support of Machine Learning, ...>

RC2: "Data Governance”
<Data Use Policy & Data Sharing, Data Privacy , Ethical Data Science, ...>

RC3: "Scalable Big/Fast Data Infrastructures”
<New Hardware (CPU/GPU), Parallel & Distributed Processing, Query
Proc. & Optimization, Cost-efficient Storage, NewSQL, HTAP (Hybrid
Transaction Analytical Processing), Metrics & Benchmarks, ...>

RC4: “Cloud Services"

< Elasticity, Multi-tenancy, Performance Isolation, Multistore/Polystores
Systems, Leveraging Machine Learning, Auto-Tuning, ....>

29
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II1.2. HTAP Hybrid Transaction Analytical Processing (2/5) [Val 22]

B Context:

® OLAP (Online Analytical Processing): Querying and analyzing
data for decision-making and strategic purposes

® OLTP (Online Transactional Processing): Updating a consistent DB

B Main Characteristics MC:
® OLAP: Complex Queries, High Performance & Availability

® OLTP: Simple Update Queries (Insert, Delete, Modify),
Consistency (Coherence ) of DB, ACID Properties.

=>» “OLTP helps run a business while OLAP helps to understand it”
B Limitations: OLAP & OLTP are separately Managed (See their MC)

B Objective: is to unify the 2 systems in a single system, making it
possible to simultaneous perform complex queries and updating
requests in real-time.
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II1.3 Future Research Directions (3/5)
®» Contribution of Machine Learning for Query Optimization

B Optimizer Structure= < St, Sp, C> [Gan 92]

— St: Search Strategies (= Intelligence)
® <Physical Optim., Parallelization, Resource Allocation, ...>

— Sp: Search Space (= Control)
o Data Structures/Queries: Linear Spaces, Bushy Space
 Type/Nature of Queries

— C: Cost Models (= Knowledge)
o <Metrics, System Environment Description>

» Estimation errors in metric values

Could Machine Learning ML effectively
improve estimation errors?
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II1.3 Future Research Directions (4/5)

B Open Issues wrt Query Processing and Optimization

P1: Elastic Resource Allocation & Dynamic Data Replication
[Kouri 13, Gra 13, Unter 14, Wong 15, Tan 16, Yin 18, Mok 20, ... ]
P2: Data Skew & Load Balancing
[Ram 12, Guf 12, Kwon 12/13, Eim 14, Akba 15, ....]

P3: Data Partitioning & Redistribution (Reshuffling Issue in MR)
(Optimization of Data Comm. in // DB Systems) [Chu 15, Lir 13, Sakr 12, ...]

P4: Big Data Indexing [Val 14, ...., Knuth 73]
=» [Val 14] “Indexing and Processing Big Data”
In: Mastodons Indexing Scientific Big Data, Paris, January 2014.

32
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I11.4 Future Research Directions (5/5)

M P1: Elastic Query Optimization [...,Yin 18, Mok 20, ...]
® Resource Allocation: Scheduling/Placement of Data/Tasks
® Dynamic Data Replication
® Cost Models :=<High Performance, Cost-effectiveness>

®» Designing of Dynamic Execution Models:

Efficient (Tenant) & Cost-effective (Provider)
®» Objective Function: Find the best trade-off between

- Multi-tenant Satisfaction (QoS (e.g. Response Time)) &
- Cost-effectiveness of Provider Services <IaaS, PaaS, DBaaS/ SaaS>
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IV. Summary & Conclusion : Evolution of Data MS:

<Concept =>» Systems: Objective>

File Management Systems: Storage Device Independence

Uni-processor Rel. DB Systems DBMS [Codd 70]: Data —Prog. Indepen
Parallel DBMS [Dew 92, Val 93]: High Perfor., Scalable & Data Availability
Distributed DBMS [Ozs 16]: Location/Frag./Replication Transparency

Data Integration Systems [Wie 92]: Uniform Access to Het. Data Sources
Characteristics =<Distribution, Heterogeneity, Autonomy>

Data Grid Systems [Fos 04, Pac 07]: Sharing of Available Resources
Mobile Database Systems [0za 08, Mor 11]: Decentralized Control
Cloud Data Manag. Systems: <Pay-Per-Use> = Economic Models

1st Gen. : SQL-on-Hadoop Systems; 2"9 Gen.: Extension of Par. RDBMS with
“Cloud Concept”; 3'4 Gen.: Multistore/Polystores Systems

Characteristics =<Elasticity, High Performance, Fault-Tolerance>
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IV. Summary: Main Characteristics of Cloud DMS: G1, G2 & G3
B Main Characteristics of 1st G1: From MapReduce = SQL Like

® "One size does not fit all” : Systems are based on Type of Data Store
® Low Performance : <Selection Queries=one pass>

® Extensive Materialization I/O: initially, the Pipeline has not been implemented!
® Loss of Data Structure — Prog. Independence (Initially!)

®» Weak Fault-Tolerance (Pipeline Parallelism)
Ind. Prod. : Bigtable, Hive, MongoDB, Cassandra, Neo4j, Riak, Spark, ...

B Main Characteristics of 2"d G2: Multi-tenant Parallel RDBMS

® + High Performance (Partitioned, Indep., Pipelined //) : = Complex Queries
® + Decla. Query Languages & Optimizer — Parallelizer & Minimization of Comm. Costs
® - Poor Semantic (Relational Model, “One size does not fit all”! )
®» <High Performance & Elasticity> ... Weak Fault-Tolerance ?
Ind. Prod. : Amazon Redshift, Azure SQL DW, Google BigQuery, Snowflake DW, ...

B Main Characteristics of 319 Generation G3: Multistore/Polystores Systems
® <Distribution, Heterogeneity, Autonomy-

® “Provide integrated access to different data stores (e.g. HDFS, SQL, NoSQL)
through one or more query languages”
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IV. Conclusion (1/4): Maturity of Big Data Manag. Systems/Cloud

B Query Languages
® Declarative Languages
® Standardization

B More Experimentation & Benchmarking
® TPC—H&TPC -DS
B Administration & Tuning/Supervision Tools

M Let time do its work!
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IV. Conclusion (2/4): Criteria for Choosing a Data Mana. System?

B C1: Price ® Investment VS Pay-Per-Use (Cloud Computing Platform)

B C2: Characteristics of Applications (Objectives & Evolution)

® Nature of Applications: OLAP, OLTP, Hybrid (HTAP)

® Data Models/Structures: File, DB, XML, ....

® Degree of Schema (Sem) Evolution (Data — Prog. Independence)
® Template Queries: Type & Nature of Queries and Indexing

B C3: Characteristics of DM Systems (System Infrastructures)

® Environment: Uni-proc., Parallel, Distributed

® Fundamental Functionalities: DDL, DML, Programming
Languages (Java/C + SQL), Consistency Constraints, ...

® DMS Administration & Tuning
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IV. Conclusion (3/4): Impacts of CDMS on Scientific & Social Aspects
1. Scientific Aspects (1/2) :
"The Beckman Report on Database Research” [Abadi et al. 2016]

® "Many early Big Data Mana. Systems BDMS Abandoned of DBMS

Principles (e.g. Declarative Programming and Transactional Data
Consistency) in favour of Scalability, Elasticity & Fault-Tolerance on
Commodity Hardware” .

® “The latest generation of DBMS is rediscovering the value
of these principles and is adopting concepts and
methods..."that have been mastered by the DB Community DBC.

» “"Building these systems on these principles, the DBC is well
positioned to drive improvements ....."”
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IV. Conclusion (4/4): Impacts of CDMS on Scientific & Social Aspects

1. Scientific Aspects (2/2)
<Concepts, Approaches, Methods, Tech/Tools> & <Applications>

® New "Concept” introduced by the Cloud Computing CC
In terms of: <Data Models, DM Languages> ?

®» Economic Models in the Resource Management (Elasticity)
Rationalization & Cost-effectiveness!

® Risk of a Gradual Shift of Fundamental Research Activities towards
only Engineering Activities
» Best trade-off between: <Fund. Research & R&D>

2. Social Aspects: Feedback from Industry and Institutions
®» Evaluation of benefits and social impacts of CDMS?
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Thank you for your attention

Contact: Hameurlain@irit. fr

Informatics Research Institute of Toulouse IRIT
Pyramid Team

Paul Sabatier University
Toulouse , France
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MapReduce Processing [val 2010]

map reduce
(keyl, vall) —— list (key2, val2) (key2, list(val2)) ——val3
e
(k2,v
- (k2,v

(k1(v,v,v))><Reduce»—

Mg
’ (2,(v,v. )~ eREHEE>>

Input Data Set

Mk] V

(k2,v
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Combiner & Partitionner [Val 2010]

(K1, V1)

list (K2, V2)

(K2, list(V2))

V3
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